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1. Introduction 
 
The purpose of this document serves as a basic self-tutorial guide for users to 
familiarise themselves with the Elixir Repertoire Report Designer. These step-by-step 
exercises will assist users in understanding the following processes: 
 
1. Report template creation 
2. Inclusion of data cube 
3. Implementation of horizontal boxes 
4. Rendering Excel behaviour 
 i) Paged 
 ii) Snapped 
 iii) Forced numbers as text (version 7.3 onwards)  
 

 
 
A report template rendered to Excel “as is” (above) and when rendered with the 
“paged” option (below).   
 

 



___________________________________________________________________________________ 
Copyright © 2008 Elixir Technology Pte Ltd  Page 4 of 28 
 

2. Elixir Repertoire Report Designer Environment  
 
Below is a brief overview of the work area that users will be working with throughout 
these exercises: 
 
 
 
 

 
 
 
 

Navigation View 

Property View 

Tab
s 

Section Viewer 

Tool Bar 
Workspace 

Repository 
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3. Orientation and Shortcut Commands 
 
General Shortcuts: 
 
Actions Shortcut Commands 
Copy Ctl + “C” 
Paste  Ctl + “V” 
Undo Ctl + “Z” 
 
 
For Repository: 
 
Actions Shortcut Commands 
Copy a File Highlight, Ctrl+Move mouse 
Move a File Highlight, Move mouse 
Copy Repository URL Right Click, select “Copy URL” 
Invoke Menus on Folder Right Click on Folder 
Add element to Report Design Area Click on Report Element, Click on empty 

Canvas Area 
Add/Remove ruler Click on Ruler Area ( Horizontal/Vertical) 
 
 
Report Layout: 
 
How to select more than 1 element 

- Click and Drag Select elements or 
- Select 1 report element and Ctrl-Select another 
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4. Installing Elixir Repertoire Designer 

4.1. Installation Requirements 
 
Elixir Repertoire supports any Java SE version 5.0 Runtime Environment (JRE) 
update 12 (or later) compliant platforms such as the following: 
 
• Windows 
• Solaris (including 10) 
• AIX 
• Linux 
• Macintosh OS X (10.2 or higher) 
 

4.2. Software Requirements 
 
Elixir Repertoire requires the following software to run. Please make sure you install 
the software prior to installing Elixir Repertoire: 
 
·  The software requires a Java SE version 5.0 Runtime Environment (JRE) update 

12 or later. If you do not have Java pre-installed, please download and install it 
from: http://java.sun.com/javase/downloads/index.jsp or from your preferred 
vendor. 

·  Adobe Acrobat PDF viewer plug-in on the client web-browser 
 

4.3. Hardware Requirements 
 
Elixir software is able to run on a usual entry level system available in the market. As 
long as the operating system and the Java runtime are able to operate smoothly, Elixir 
software itself only requires an incremental amount of RAM.  
 
You may refer to the “System requirements for the Java Runtime Environment 5.0” at 
http://www.java.com/en/download/help/5000011000.xml. 
 
For Elixir Repertoire Designer, a recommended minimum RAM configuration would 
be 256MB, and for more advanced usage, 512MB is recommended. 
 
In addition, a total of 150MB disk space is recommended for the following: 
• 50 MB for Elixir Repertoire Designer application files, documentations and samples 
• Up to 80 MB for the Java runtime (depending on the version) 
• 20 MB reserved space for other 3rd party add-on software like database drivers. 
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4.4. Before Installation 
 
Ensure you have Administrator privileges. If you are installing Elixir Repertoire on a 
computer running any of the supported operating systems (see Installation 
Requirements above), you must have Administrator privileges. The installation 
process creates registry entries and may update some system files that require 
Administrator rights. 
 

4.5. Ensure Java is Pre-Installed 
 
The software requires a Java SE version 5.0 Runtime Environment (JRE) update 12 or 
later. If you do not have Java pre-installed, please download and install it from 
http://java.sun.com/javase/downloads/index.jsp or from your preferred vendor.  
 
To find out if your system has the correct version of Java installed, go to the 
command prompt and key in the following: 
 
java -version  
 
The system will return the following as an example: 
 

 
 

4.6. Installing Elixir Repertoire 
 
·  For any Java enabled platforms, please unzip Repertoire7.x.x.zip to a specific 

installation path. Deploy the database drivers and license keys accordingly (see 
“Installing Database Drivers and Additional Class Files” and “Deploying the 
License Key”). Create a start up shell script (.sh file) as shown in “Running Elixir 
Repertoire Designer in Debug Mode”. 

 
·  For Windows Platform, please click and run Elixir Repertoire Installer 7.x.x.exe 

to begin guided installation. 
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An installation path dialog box appears for you to choose your desired installation 
location. Default installation directory is C:\Program Files\Elixir Repertoire 
 
Do take note that if you are installing an upgrade of Elixir Repertoire, the installation 
wizard will prompt you with a warning, stating that the new version will be installed 
at the default location, thus overwriting your old version of Elixir Repertoire. If you 
wish to keep the previous version, do change the installation path to prevent 
overwriting the old version. 
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You will then be prompted to select the various components for installation. Leave the 
selection as is and click “Next” to continue. 
 

 
 
Change the name of the start menu folder containing the Elixir Repertoire shortcuts 
and leave it as is and click “Next” to continue with the installation. 
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Click “Next” to proceed with the installation. Depending on the speed, the installation 
of Elixir Repertoire will be completed in a few minutes. 
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4.7. Installing Database Drivers and Additional Cla ss Files 
 
The installation of database drivers and additional 
Java class files can be installed in the /ext directory of 
the Repertoire installation.  
 
Database drivers must support JDBC connectivity and 
be packaged as jar files. An example of a typical /ext 
directory may look like the following example: 
 
 
 

 
    

 

4.8. Deploying the License Key 
 
Copy the license key, e.g. ElixirRepertoire7-Designer-license.txt or ElixirRepertoire7-
Designer-license.zip to $USER_HOME directory, eg. C:\Documents and 
Settings\User before running Elixir Repertoire Designer. 
 
If the application starts up with a message that the 
license key cannot be found, access the “Global 
Properties” to manually install the license key. 
 
At the “Global Properties” dialog box, 
access the first tab, “License” and click 
on the “…” button to select the location 
of your license key. Select the license 
key and click “Open”. The “Global 
Properties” dialog box will now display 
the licensing details.  
 
Click on “Install License” to deploy the 
license key followed by “Ok” when 
done. 
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4.9. Starting Elixir Repertoire Designer 
 
Once the key is deployed, run the 
software from the start menu by 
accessing the Elixir Repertoire 
folder followed by the Elixir 
Repertoire icon.  
 
Alternatively, the Elixir Repertoire 
executable can also be accessed from 
the /bin directory of the Repertoire 
installation path. 
 
 

 

4.10. Running Elixir Repertoire Designer in Debug M ode 
 

 
 
Running Elixir Repertoire Designer in debug mode allows users to monitor and track 
any errors arising from the design of their report templates and data sources. To run in 
debug mode, open a text editor and input the following as a single line, modifying the 
text in bold according to your own environment: 
 
"C:\Program_Files\java\jre1.6.0_02\bin\java.exe" -mx512m -classpath 
.\Repertoire-Launcher.jar com.elixirtech.repertoire.Launcher   
 
Save the text as a batch file (.bat) in the /bin directory of the Repertoire Designer 
installation and execute this .bat to run in debug mode.  



___________________________________________________________________________________ 
Copyright © 2008 Elixir Technology Pte Ltd  Page 13 of 28 
 

5. Preparing the Exercise Environment  
 
This exercise is part of a series of self-help practices 
and tutorials to get users familiarised with the 
Repertoire Designer. Each exercise is categorised based 
on specific features. To get started, create an 
“ER_Exercises” folder and a “Report-Designer” 
subfolder if you have not done so from pervious 
exercises. Unzip the “Ex_Excel” folder into 
“ER_Exercises/Report-Designer” so that the directory 
structure would be “ER_Exercises/Report-Designer/ Ex_Excel” as shown in the 
example.   
 
In the Repertoire Designer environment, the 
“ER_Exercise” folder needs to be added to the 
repository to access the files. To begin, click on 
the “Add Filesystem” button. 
 
Highlight the option “Local Filesystem” and 
click on “Next”. Go to “Directory” and click on 
the “…” button. Select the “ER_Exercises” 
directory and click “Open”. In the “Name” field, 
input “ER_Exercises”. The pop dialog should 
look like the example below. Click “Finish” to 
continue. 
 

 
 
 



___________________________________________________________________________________ 
Copyright © 2008 Elixir Technology Pte Ltd  Page 14 of 28 
 

The “ER_Exercises” will appear in the repository as 
shown in the example. 
 
If the “ER_Exercises” directory and “Report-
Designer” sub directory were created from a 
previous exercise, unzip the “Ex_Excel” exercise 
directory accordingly. Ensure that the folder 
structure appears accordingly in the example shown. 
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6. Understanding the Excel Output Format 
 
The Excel output format uses relative positioning where the layouts and alignments of 
each element are dependent on their positions. To ensure that the rendered output 
meets requirements, users should pay attention to the following pointers: 
 

- Use Vertical/Horizontal boxes to ensure all fields are correctly placed within 
the report template  
 

- Remove any unwanted spacing between and within bands (Eg. Page Header, 
Section Header, Detail etc)  
 

- Use the ruler to snap in the fields, and ensure the whole report uses this similar 
ruler's marking  
 

- Ensure data fields do not overlap each other   
 

- Ensure data fields used between the bands follow strictly to the ruler's 
marking, to avoid creating additional "empty" cells  
 

- Check the Snap box to automatically adjust the layout of the excel cells (varies 
from case to case) 

 

6.1. Colour Selection 
 
Microsoft Excel has a default colour palette of 56 colour Indexes. Therefore, selecting 
a colour from the Repertoire Designer palette may not produce the same results in the 
excel output. It is therefore advisable to select colours that are compatible with 
Microsoft Excel. 
 

7. Part 1: Employee Summary Report 
 
The Employee Summary Report consists of the following sections: 
 
- Summary Table 
- Employee Details 
 
 
The creation of this report template will be covered in this step by step guide. 
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7.1. Create Employee Details  
 
We will first create the employee details section of the report. Employee details that 
would be presented are their employee ID, first name, last name as well as their 
salary. This section will then be designed to present these details based on the 
following breakdown: 
 

- Employees grouped by their management role 
- Employees grouped by education levels in each department 
-  

To begin, create a new blank report template. Right click on the work folder, select 
“Add” followed by “report template”. Follow the wizard instructions and select 
“Blank Report” template for this exercise.  
 
Now go to “Page Setup” in the “Report” tab, right click on the current page setup 
(which in this case is “Default”) and select “Edit Page Setup”.  
 

  
 
Set all the margins to 0 and click on “Finish” when done. 
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7.2. Adding a Data Source 
 
Every report template requires a data source which stores data or information that has 
been retrieved from a database or flat files (csv, excel) to be presented in the report 
template.  
 
Data sources can be added to a report template either through the Report Wizard 
during creation or in the “Report” tab of the template’s workspace. Each report 
template can have more than one data source and users are able to select which data 
source is to be used by which section. 
 

 
 
To manually add a data source to the template, go to the “Report” tab, look for the 
template structure on the left of the workspace and right click on the DataSources 
node to add a data source. Name the data source “employees” and follow the steps in 
the wizard to finish the process. 
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7.3. Adding a Page Title Header 
 
1. Add an image element to the “Page Header” of the template workspace. This can 
be either done through dragging and dropping the image file onto the “Page Header” 
or by clicking on the image icon in the tool bar (shown below) and clicking on the 
“Page Header”.  
2. Ensure that the image URL reflects the correct image file under the image 
properties. 
 
 

 
 
 

7.4. Populating the Report 
     
1. Go to the “Layout” tab. Notice that the report template has been divided into five 
bands: 
 
- Page Header 
- Section Header 
- Detail 
- Section Footer 
- Page Footer 
 
2. Go to the “Data” tab on the right hand side of the workspace.  
3. Double click on the data source icon to expand the data columns. Each data column 
in the data source contains a specific set of data.  
4. Select and drag the “employee_id”, “first_name”, “last_name” and “salary” 
columns onto the “Detail” band.  
5. A field layout wizard will appear. Select the “Horizontal” tab and check “Show 
Labels” and “Use Vertical Box” (see screenshot on next page).  
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6. Go to the “Shapes” tab, expand each 
horizontal box, hold “Ctrl” and click on 
the labels and fields to do a mass select.   
7. Proceed to the property view and 
expand the “Border” section.  
8. Select “Solid” from the “Style” drop 
down menu.  
9. For the labels, expand the “Font” 
section and check the “Bold” option. 
10. Expand the “Position” section and 
access the “Text Align” section to toggle 
the text alignment. 
11. Click “Finish” when done.  
 
If the report template were to be 
rendered now you would see a long list of names and their respective details with no 
form of differentiation or grouping.    
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7.5. Sorting and Grouping 
 
The next step would be to sort the employee list. 
  
1. Go to the “Report” tab, look for the “Sections” node and right click on the current 
section and select “Edit Section”.  
2. Click on the “Group and Sort” tab and click on the “Add” icon.  
3. From the drop down lists, select “management_role” for “Name”, “Ascending” for 
“Sort Order” and “Each Value” for 
“Group On”, ensuring that the group 
header and footer options are 
checked.  
4. Repeat this step for 
“education_level” ”, ensuring that the 
group header and footer options are 
checked. 
5. Render the report template 
 
The employee details retrieved from 
the data source are now sorted and grouped based on the following order: 
 
- Management Role (sorted ascending and grouped on each value) 
- Education Level (sorted ascending and grouped on each value) 
 

 
 
 
However, notice that the headers are repeated after each row of detail. Select the 
horizontal box holding the header labels in “Details”, right click and select “Cut”, go 
to the “Group Header: education_level” band and paste the horizontal box.
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7.6. Labelling 
 
1. Go to the data tab and drag the column “education_level” onto “Group Header: 
education_level”, just above the header labels.  
2. Repeat this step by dragging “management_role” onto “Group Header: 
management_role”.  
3. Add a colour for both labels and extend the data field width to fit the width of the 
page size.  
  

7.7. Setting Styles  
 
Users are able to customise style sheets which can be 
implemented on the various elements. A set of styles is 
readily available in the “Styles” section under the 
“Report” tab and users have the option to create their own 
set if needed. 
 
1. For this exercise we will modify an existing “field” 
style. Go to “Report”, expand “Styles” and right click on 
“field” and select “Edit Style”.  
 
2. In the “Style Wizard”, expand the “Font” property. Scroll down “All Properties” on 
the far left and select “Font.Bold” and add it to “Style Properties”. Once added, check 
the “Bold” option. 
 
3. Return to the “Layout” tab and 
select both “management_role” and 
“education_level” and set “Style” to 
“field” in the property view.
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7.8. Implement Aggregation Functions 
 
The next step for this report is to implement aggregation functions which will give an 
indication as to the total headcount and salaries paid each in management role 
grouping. 
 

1. Copy the horizontal box from the “Detail” band and paste it in  “Group Header: 
management_role” .  Hold “Alt” and select the first data field. Right click, select 
“Properties” and change the “Field Type” to “Literal” from the drop down menu. 
Input the following in the text field: 
 
Total Group Count: 
 
2. Access the second data field and under “Properties”, change the “Field Type” to 
“Operation”, select the “department_id” column, “Count” from the drop down below 
and check “Over Group”.  
 

 
 
3. Hold “Alt” and select the third data field. Right click, select “Properties” and 
change the “Field Type” to “Literal” from the drop down menu. Input the following in 
the text field: 
 
Total Salary: 
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4. For the fourth data field, change the “Field Type” to “Operation”, select the 
“salary” column, “Sum” from the drop down below and check “Over Group”.  Set the 
data field styles to “field” from the property view. 
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8. Part 2: Adding Summary Table 
 
The summary table will present the total number of staff in the various management 
levels according to their education qualifications. A landscape page setup will be used 
to  present this cube table. 
 

8.1. Add Landscape Page Setup 
 

 
 
1. Go to the “Report” tab and right click on the “Page Setup” node. 
2. Select “Add Page Setup” from the pop up menu. 
3. Select the “Landscape” option in the “Page Setup” wizard. 
4. Set all the margins to 0. 
5. Click “Finish” when done. 
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8.2. Create New Section 
 

 
 
1. Go to the “Report” tab and right click on the “Sections” node. 
2. Select “Add Section” from the pop up menu. Name this section “Summary Table” 
 
 

8.3. Add Cube Summary Table 
 
1. Go to the “Layout” tab of the workspace. 
2. Select “Summary Table” from the “Section” drop down menu. 
3. Add a data cube element to the “Section Header”. 
4. Under “Properties”, select “employees” as the data source and click the “Over All” 
option. 
5. Click on “Open Cube Wizard”.  
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6. Click “Next” to go to the “Cube Axes” and select “education_level” as the column 
dimension and “management_role” as the row dimension. 
 

 
 
7. Click “Next” to go to the “Cube Measures” 
section and select “department_id” and “Count” 
function. 
8. Click “Finish” and “Ok” when done. 
9. Add borders to the cube summary table by 
selecting the cube elements in the “Shapes” tab 
and setting the borders to “solid” in the property 
view. 
10. Adjust the font size accordingly for the cube labels, rows and columns via the 
property view.  
11. Add a “Summary Table” label above the cube table. 
 
We will now add a condition to the cube table whereby the background colour will 
change when the number of education level holders (Count(department_id)) is more 
than 200. 
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12. Go to the “Shapes” tab (from the layout tab) and right click the 
“Count(department_id)” cube measure.  
13. Select “Properties” followed by the “Presentation” tab. 
14. Click on “Add” for additional render options. Choose a background colour and 
select “More Than” as the “When” condition and input “200” in the text field next to 
it. Click “Ok” when done.    
15. Ensure the width of the cube place holder is equivalent to the page width. 
16. Go to the “Report” tab, and add a new row to the “Render Sequence” table. Select 
“Summary Table” and its respective data source and click “Finish”. Click on the “up” 
arrow button to move the “Summary Table” row to the top. 
 

 
 
The rendering sequence has now been set to render the summary table first before the 
report details. 
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9. Part 3: Rendering Templates to Excel Format 
 
When rendering a report template to an excel file, there are three options to consider: 
 

 
 
Paged 
Renders the report template based on the paper size specified. Similar to a report with 
pages, the excel file output will be spread across multiple tabs based on the number of 
pages.  
 
Snap 
The report elements’ coordinates are adjusted to fit on a 4x4 pixel grid. The snap 
option’s usefulness depends on the report template design.   
 
Force numbers as text (Version 7.2.3 and above) 
Enabling this option allows custom formatting to be displayed in excel as a string. An 
example would be implementing the international numbering format whereby values 
would contain commas and decimal points, e.g. 1,000,000.00.  
 
 


